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WE MISS YOU! 

JOIN US FOR OUR  
MONTHLY MEETINGS! 

Instructions on using Zoom… 

1) A Zoom meeting invitation will sent to 
everyone who is signed up on the club’s email 
list (everybody@sbamug.com). 

2) To be added to the mailing list, follow the 
instructions at https://www.sbamug.com/our-
sbamug-email-group/  

3) When you receive the Zoom invitation 
email, save the link to your calendar so that on 
the day of the meeting, you can find it more 
easily.  

4) To join the Zoom meeting, click on the link 
provided in the invitation email.  This will allow 
you to install the free Zoom app.  The meeting 
invitation will also include a meeting ID and 
password, which you may need.  

5) DO YOU NEED HELP WITH ZOOM? 
Anyone having trouble logging on to the Zoom 
meeting online should call CW Mitchell at 
310-644-3315 before the next meeting and he 
will help you get logged on.   

Yes, we know you can’t schmooze over ZOOM 
meetings…but, the upside of ZOOM is that other family 
members can also watch the meeting, you save money 
on gas, you can have your pet(s) with you, and you can 
enjoy all the drinks and snacks you want!  

Our next SBAMUG Meeting via Zoom:   
Wednesday, April 27 at 6:30 p.m.  

The April 27 meeting will begin at 6:30 p.m. 
with a Q & A Session. Everyone is welcome, 
and any and all questions are encouraged, 
from beginner to advanced. The main 
presentation will begin about 7:15 p.m. Jim 
Pernal will first discuss the Mac OS Sidecar 
and new Universal Control that will let you use 
your iPad and/or other Mac computers as 
additional displays without needing to buy and 
connect other monitors. Next he will briefly 
discuss monitor specs and buying decisions. 
Links to monitor buying guides will be given.  
Then we will discuss the various types of 
ports on Macs to connect displays. Finally 
some example hookups will be shown. 
Join us for an interesting and informative 
meeting!

mailto:everybody@sbamug.com
https://www.sbamug.com/our-sbamug-email-group/
https://www.sbamug.com/our-sbamug-email-group/
https://www.sbamug.com/our-sbamug-email-group/


                                                                                                                       

  Virtual Meetings:  Online via Zoom 
  In-Person Meetings:  Lomita VFW Hall 
  1865 Lomita Blvd., Lomita 
  Mailing Address:  C.W. Mitchell 
  4861 W. 136th St., Hawthorne CA 90250-5631 
  Phone:  (310) 644-3315    
  Email:  info@sbamug.com 
  Website:  http://www.sbamug.com 

Members, friends and colleagues are invited to attend 
our monthly meetings (usually the last Wednesday of the 
month).  Annual membership entitles you to receive this 
online monthly newsletter, plus many more benefits (see 
page 8).   The $35 annual membership dues are 
waived for 2022.  Visit sbamug.com to become a 
member or to get more information.  Meetings will be 
held virtually via Zoom until further notice. 

  SBAMUG Virtual Meeting Format: 

  6:30-7:15 p.m.   Question & Answer Session    
  Everyone welcome, beginners encouraged! 

  7:15-8:00 p.m.   Announcements & Presentation 

 Other Meetings: 
• Tuesday (6 days after last Wednesday) -  

SBAMUG Core Group, 7:30 p.m. on Zoom.  
Contact CW Mitchell at cwmitchell@sbamug.com 
or send email to info@sbamug.com for core group 
Zoom meeting invite.  

• 3rd Thursday every other month - InDesign User 
Group, 7:00 p.m. at various locations in LA area, 
laidug.com 

•  Last Saturday each month - Northrop Grumman - 
Ham Radio & Computer Swap Meet, 7:00-11:30 
a.m.  Meet at SE corner of Marine/Aviation Blvd, 
Redondo Beach  (visit w6trw.com to see if swap 
meet is cancelled due to Covid-19) 

•  Los Angeles Portable Users Group:  Mac OS X, 
iPhone, iPod, MacBook, etc. at lapug.org/ 

• Find more:  http://www.apple.com/usergroups/

  Officers & Volunteers: 
President:  Kent McDonald     
Vice President:  Jim Pernal 
Secretary:  Nancie Silver       
Treasurer:  C.W. Mitchell 
Directors at Large:  Dave Nathanson, Arnold 
Silver, George Wilde, Joan King 
PD Disk Editor:  Jim Pernal     
Membership:  C.W. Mitchell    
Member Development:  Nancie Silver 
(publicity). Jim Pernal (website updates) 
Programming:  Kent McDonald       
Server Director:  Dave Nathanson 
Newsletter:  Nancie Silver 
USPS Liaison:  C.W. Mitchell 
Refreshments:  Arnold Silver/Andy Paroczai 

Membership Report:  

71 members (as of 4/8/22) 

Thank You, Member Renewals!        
Steven Barryte, John Baskett, Mike Pauls, 
Ray Chikahisa 

Membership-related Information/Questions: 
Contact CW Mitchell at cwmitchell@sbamug.com 
- for information about membership, dues and  

benefits 
- if your name is misspelled or the expiration date 

is incorrect on your membership card 

Two EASY Ways To Renew! Look for renewal 
letter  
1 - Sign and date the form and return it with  
     payment* using the enclosed self-addressed   
     envelope; or 
2 - Bring form and payment* to meeting (when in-     
     person meetings resume**) 

*No payment required for 2022 as club fees have been 
waived 
**At in-person meetings, please wear your membership 
card as a name tag. Your first name is larger so it’s 
easier to read. 

THE SOUTH BAY MUG (ISSN 1058-7810) is published monthly for $35 per year by South Bay Apple Mac User Group, 28110 Ridgeforest Court, 
Rancho Palos Verdes, CA 90275. Periodicals postage paid at El Segundo, CA and at additional mailing offices.   
POSTMASTER: Send address changes to THE SOUTH BAY MUG, c/o CW Mitchell, 4861 W. 136th Street, Hawthorne, CA 90250-5631. 
The South Bay MUG is published by the non-profit South Bay Apple Mac User Group. Excerpts may be reprinted by user groups and other non-profit 
media. Credit must be given to SBAMUG and the author. In addition, a copy of all reprinted materials must be sent to us at the above address. The 
South Bay MUG is an independent publication not affiliated or otherwise associated with or sponsored or sanctioned by Apple® Computer, Inc. The 
opinions, statements, positions and views stated herein are those of the author(s) or publisher and are not intended to be the opinions, statements, 
positions or views of Apple® Computer, Inc.

Welcome to the SBAMUG! 
(South Bay Apple Mac User Group)  
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SBAMUG April 2022 Shareware 

Spring is here!  Six items this month. 
  
AirParrot 3.1.3:  Apple’s Airplay will not work 
on before mid-2011 Macs.  This utility will 
allow you to mirror you Mac’s display on your 
Apple TV; much like Airplay does for newer 
Macs.   
OS 10.10+ $17.99   
https://www.airsquirrels.com/airparrot/
download?hsLang=en 
  
Carbon Copy Cloner 6.1.1:  This program 
lets you use backup/clone your hard drive. 
Bug fixes in this latest version. MacOS 10.15+ 
$39.99  
https://bombich.com 

Downcast 2.11.7:  This program lets you 
download play and sync podcasts. Variable 
speed playback. Scheduling. View show 
notes. Mac OS 10.15+ $4.99 Mac App Store 
  
iStat Menus 6.62:  Monitor your Mac from the 
menubar.  CPU, Memory, Network, Temps and 
more.  MacOS 10.11+ $11.99   
https://bjango.com/mac/istatmenus/ 

Mochi 1.13.8:  Flash Card program to help 
you study. Spaced repetition.    Mac OS 
10.10+ Free https://mochi.cards 

SeaMonkey 2.53.11:  Alternative Web 
browser Client. Has Email, Newsgroup, and 
IRC chat as well as HTML editor. Same base 
code as Firefox. Mac OS 10.9+ Free  
https://www.seamonkey-project.org 
  
See you at the April meeting online. 
  
Jim Pernal, PD Editor 

Helpful Links 

Four links about the best charging stations: 

https://www.cmd-ltd.com/advice-centre/usb-
chargers-and-power-modules/usb-and-
power-module-product-help/everything-you-
need-to-know-about-wireless-phone-
charging/#wireless6 

https://www.techjunkie.com/charging-station-
apple-products/ 

https://www.techradar.com/news/wearables/
10-of-the-best-apple-watch-docks-1320648 

https://www.electronicshub.org/best-3-in-1-
apple-charging-station/ 

Test internet speed in MacOS: 
https://www.macrumors.com/how-to/test-
internet-speed-macos/ 

How to scan printed and handwritten motes 
into the Notes App in iOS 15.4: 
https://www.macrumors.com/how-to/scan-
printed-handwritten-notes-app/ 

Everything you need to know about the Files 
app on your iPhone: 
https://www.makeuseof.com/tag/use-ios-
files-app-iphone-ipad/ 

How to use the Magnifier on iPhone or iPad: 
https://www.imore.com/how-use-magnifier-
iphone-and-ipad 

Download Apple’s official iPhone repair 
manuals for free: 
https://9to5mac.com/2022/04/27/download-
iphone-repair-manuals/

More fun with words… 

Going Beyond Wordle:  Oodles of *dle Games 

https://tidbits.com/2022/04/20/going-beyond-wordle-oodles-of-dle-games/

https://www.airsquirrels.com/airparrot/download?hsLang=en
https://www.airsquirrels.com/airparrot/download?hsLang=en
https://bombich.com/
https://bjango.com/mac/istatmenus/
https://mochi.cards/
https://www.seamonkey-project.org
https://www.cmd-ltd.com/advice-centre/usb-chargers-and-power-modules/usb-and-power-module-product-help/everything-you-need-to-know-about-wireless-phone-charging/%23wireless6
https://www.cmd-ltd.com/advice-centre/usb-chargers-and-power-modules/usb-and-power-module-product-help/everything-you-need-to-know-about-wireless-phone-charging/%23wireless6
https://www.cmd-ltd.com/advice-centre/usb-chargers-and-power-modules/usb-and-power-module-product-help/everything-you-need-to-know-about-wireless-phone-charging/%23wireless6
https://www.cmd-ltd.com/advice-centre/usb-chargers-and-power-modules/usb-and-power-module-product-help/everything-you-need-to-know-about-wireless-phone-charging/%23wireless6
https://www.cmd-ltd.com/advice-centre/usb-chargers-and-power-modules/usb-and-power-module-product-help/everything-you-need-to-know-about-wireless-phone-charging/%23wireless6
https://www.techjunkie.com/charging-station-apple-products/
https://www.techjunkie.com/charging-station-apple-products/
https://www.techradar.com/news/wearables/10-of-the-best-apple-watch-docks-1320648
https://www.techradar.com/news/wearables/10-of-the-best-apple-watch-docks-1320648
https://www.electronicshub.org/best-3-in-1-apple-charging-station/
https://www.electronicshub.org/best-3-in-1-apple-charging-station/
https://www.macrumors.com/how-to/test-internet-speed-macos/
https://www.macrumors.com/how-to/test-internet-speed-macos/
https://www.macrumors.com/how-to/scan-printed-handwritten-notes-app/
https://www.macrumors.com/how-to/scan-printed-handwritten-notes-app/
https://www.makeuseof.com/tag/use-ios-files-app-iphone-ipad/
https://www.makeuseof.com/tag/use-ios-files-app-iphone-ipad/
https://www.imore.com/how-use-magnifier-iphone-and-ipad
https://www.imore.com/how-use-magnifier-iphone-and-ipad
https://9to5mac.com/2022/04/27/download-iphone-repair-manuals/
https://9to5mac.com/2022/04/27/download-iphone-repair-manuals/
https://tidbits.com/2022/04/20/going-beyond-wordle-oodles-of-dle-games/
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Five Solutions for  
Pasting Plain Text on a Mac 

  
Tell me if you’ve had this problem: you copy 
some text and paste it into a word processor, 
a spreadsheet, or any other app that supports 
stylized text and end up with text that looks 
different than the rest of your text. It may be a 
different font, font size, or color. Once it’s 
there, fresh text you add afterward takes on 
that formatting such that you find yourself 
fussing with formatting instead of focusing on 
your writing or editing. 

By default, pasting text into many Mac apps 
brings with it any styling that had been 
applied. Maintaining text styles is often 
desirable—particularly when duplicating or 
moving text around within a document—but 
it’s often an annoying waste of time when 
you’re bringing content into a document from 
another app. In such situations, it’s best if you 
can paste just the text itself and have it take 
on the styling of the text around it. 

There are numerous ways to solve this 
problem. Some are free, and others take 
advantage of a commercial utility that you may 
already have for another purpose. If the built-
in solutions don’t work in your particular 
workflow, turn to one of the alternatives. 

Built-in Solution:  Paste and Match Style 

Apple has long acknowledged this need with a 
command in the Edit menu: Paste and Match 
Style. Many other apps mimic the naming of 
Apple’s command, although you may also see 
variants like Paste and Match Formatting 
(Microsoft Word), Paste Text Only (Nisus 
Writer Pro), Paste without Formatting (Adobe 
InDesign), and Paste Without Format (Affinity 
Publisher). 

For something as commonplace as pasting, a 
keyboard shortcut is welcome, and Apple’s 
default is Command-Shift-Option-V. That 
works in many apps, although the slightly 

simpler Command-Shift-V is also frequently 
used—it’s what you’ll find in Adobe InDesign, 
Nisus Writer Pro, and even the Web interface 
of Google Docs. 

For the vast majority of situations, the built-in 
approach is all you need. Occasionally, 
however, you’ll find yourself in a situation 
where there seems to be no way to strip 
styling while pasting. Here are some 
alternative approaches that should work 
anywhere. 

Quick and Clunky:  Run It through a 
Plaintext Editor 

If you already use a plaintext editor like 
BBEdit, a simple way to strip that unwanted 
formatting is to paste the text into a new 
document, select all, copy again, and paste it 
in its final destination. This approach works 
because BBEdit and similar apps pay no 
attention to text styling—they care only about 
the characters. It’s a fine workaround for 
infrequent use, but it’s slow and inefficient. 

Pure Paste for Monterey 

For a smoother and more flexible way of 
pasting plain text by default, check out Pure 
Paste. It lives in your menu bar and, by 
default, strips formatting from your clipboard 
automatically. You can override it on a per-
copy basis, and it allows you to exclude 
particular apps for which pasted text should 
always come in with its formatting. Other 
options let you optionally preserve HTML links 
and remove tracking parameters from URLs. 

Pure Paste is free, has no ads, collects no 
personal information, has no network 
connectivity, and ignores anything copied 
from a password manager. The only downside 
is it requires macOS 12.3 Monterey or later. 

TextExpander 

TextExpander enables you type an 
abbreviation to expand it into a longer word or 
phrase. For example, I type xte instead of 

https://www.barebones.com/products/bbedit/
https://apps.apple.com/us/app/pure-paste/id1611378436?mt=12
https://apps.apple.com/us/app/pure-paste/id1611378436?mt=12
https://textexpander.com/
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3. Click the New Trigger button, choose 
Hot Key Trigger, and press 
Command-Control-V (or whatever you 
like). 

4. Click the New Action button, search 
for “Filter” in the Actions list, and 
double-click it to add it to your macro. 

5. Leave the Filter pop-up menu set to 
System Clipboard and the To pop-up 
menu set to Source, but from the With 
pop-up menu, choose Remove 
Styles. 

6. Back in the Actions list, search for and 
add the Paste action. 

 

Then, whenever you press Command-
Control-V, Keyboard Maestro looks at 
whatever is on the clipboard, filters out all 
the styles, and pastes it in whatever text field 
contains the insertion point. 

More Than One Way to Skin a Character 

I won’t pretend this list is anywhere near 
comprehensive—there are many ways to 
paste plain text. Glenn Fleishman is a fan of 
Pastebot from Tapbots. The Mac App Store 
also has the Paste Plain Text menu bar app, 
though it asks for your email address. And 
finally, those who use Microsoft Office should 
also be aware of the Paste Options button, 
which lets you decide after pasting if you 
want to keep the formatting of the source 

TextExpander. Less well-known is the fact that 
it can also strip formatting from clipboard text. 
While I wouldn’t recommend subscribing to 
TextExpander just for this feature, if you 
already own it, you can create a snippet that 
pastes the clipboard contents without 
formatting. Follow these steps: 

1. Choose File > New Snippet. 

2. Make sure the Content menu is set to 
Plain Text. 

3. From the little keyboard icon, choose 
Clipboard to insert the Clipboard token 
into the snippet. 

4. In the Label field, give it a name like 
“Paste Plain Text.” 

5. In the Abbreviation field, enter the 
abbreviation you’ll type to invoke the 
paste. 

 

For the abbreviation trigger, I use xpt since I 
prefix all of my TextExpander shortcuts with “x” 
to make them unique and easy to type on both 
macOS and iOS. 

Keyboard Maestro 

If you already use Keyboard Maestro to 
automate actions on your Mac, it too offers the 
capability to strip formatting when pasting text. 
It takes only a minute to create a Paste Plain 
Text macro: 

1. Choose File > New Macro. 

2. Enter “Paste Plain Text” in the name 
field at the top. 

https://www.keyboardmaestro.com/
https://tapbots.com/pastebot/
https://apps.apple.com/us/app/paste-plain-text/id1407015686?mt=12
https://support.microsoft.com/en-us/office/hide-or-display-the-paste-options-button-dace7144-924d-4bcc-a964-5fbe1f3fedab%23ID0EBBD=macOS
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SBAMUG Membership Application 
South Bay Apple Macintosh User Group provides you with a 

local source of shared knowledge & experience through 
monthly meetings, trainings and monthly newsletter. 

Individual & Family Memberships:  $35 per year* 
(*membership fee is waived for 2022) 

! New Member(s)          ! Member Renewal 

 Name:__________________________________________ 
 Spouse/Partner Name:_____________________________    
 Address:________________________________________ 
 City:___________________________________________    
 State:_______________________    Zip:______________ 
 Home Phone: (_____)_____________________________  
 Member Cell: (_____)_____________________________  
 Spouse/Partner Cell: (_____)_______________________ 
 Member Email Address:____________________________ 
 Spouse/Partner Email:_____________________________ 
 Member computer interests: ________________________ 
 Spouse/Partner computer interests:___________________    
 Devices you use most:_____________________________ 
 Current level of Mac expertise: 
 Member: ___ Beginner    ___ Intermediate     ___Advanced 
 Spouse/Partner: ___ Beginner  ___ Intermediate   ___Adv.    
 How did you hear about SBAMUG?___________________ 
 _______________________________________________ 
 I would like to help with the club. Please contact me at: 
 ______________________________________________ 
 Comments:_____________________________________ 
 ______________________________________________ 
 Signature: _____________________________________ 
 Date: _________________________________________ 
 Mail your Application (no check needed for 2022) to our mailing       
 address (see page 2), or bring to our monthly meeting at VFW  
 Hall when in-person meetings resume. 

SOUTH BAY APPLE MAC USER GROUP 
c/o C.W. Mitchell 
4861 136th Street 
Hawthorne, CA 90254-5631

Join, Renew or Give a Gift of a 
SBAMUG Membership! 

 For only $35 per year*, you get: 
• Monthly meeting presentations 
• Get help from our experts via our     

Email Group   
• Monthly newsletter (We publish 11 

issues per year!) 
• Use our Wiki  
• Free web space & e-mail on our 

server 
• Build your own website 
• Create your own blog  
• Special merchant discounts $$$ 
• Occasional swaps, free software, 

opportunity drawings  
 http://www.sbamug.com/join.html  

or contact Membership Chair  
CW Mitchell at 

cwmitchell@sbamug.com  
  *($35 membership fee waived for 2022)

you’re pasting, match the formatting 
of the destination where you’re 
pasting, or just paste plain text. 

 
If you have another solution for 
pasting plain text that you prefer, 
tell us about it in the comments. 

Article written by Josh Centers on April 18, 
2022   

Reprinted from TidBITS; reuse governed 
by Creative Commons license. TidBITS 
has offered years of thoughtful 
commentary on Apple and Internet topics. 
For free email subscriptions and access to 
the entire TidBITS archive, visit 
tidbits.com. 

http://tidbits.com
http://www.sbamug.com/join.html
mailto:cwmitchell@sbamug.com

